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In this chapter, you’ll get a quick tour of the DaVinci Resolve interface, and learn the fundamentals of 
where everything is. Working in DaVinci Resolve 10 can be as simple as following three simple steps: 
import your media in the Media page, grade it in the Color page, and render it using the Deliver 
page. Obviously, Resolve accommodates many more complex workflows, but the essence of any 
workflow is to import, grade, and deliver.

Starting Resolve and Opening a New Project

When you first open DaVinci Resolve, the Log In screen lets you either create a new user account 
with which to manage your projects, or you can log in quickly as the admin by simply double-clicking 
on the admin icon. This lets multiple colorists use the same system in facility environments.

The Log In Window

After you log in, the Project window appears. Double-clicking the Default Project icon opens a 
brand new project. Previous projects you’ve created appear here as well, and can be organized into 
folders if you like. This is also where you import projects that were created by other Resolve users.

The Project Window

Introduction to Resolve
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The Media Page

When you open a project, you’re immediately taken to the Media page, which is the first of the five 
pages in the main DaVinci Resolve user interface.

The Media Page

The Media page is where you can import media that’s not associated with a previously edited 
project. For example, if you’re organizing media that’s coming straight from a shoot, in order to 
create digital dailies for editing, you would import all of the camera original media into the Media 
page first, in order to begin working with it. Once you’ve organized the media you need to work 
with, you can also use the Media page to edit clip metadata, and to sync the audio and video of 
media acquired via dual-system acquisition.

The Media page consists of the Library, which you use to locate media on disk to import; the Media 
Pool, which stores all of the media that’s been added to the current project in one or more bins; the 
Viewer, where you can see and play individual clips; the Audio Meters, which let you evaluate each 
clip’s audio levels and which also has a mode you can use for manually syncing audio to video, and 
the Metadata Editor, where you can edit information associated with each clip.

In this example, the tutorial media you downloaded has been opened up in the Library and added 
to the Media Pool by selecting the clips and dragging, or simply double-click. Once in the Media 
Pool it’s ready for you to begin working on it.
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The Edit Page

The Edit page is the second page in the DaVinci user interface, accessible by clicking the Edit page 
button at the bottom of the window, and it’s where you can import edited timelines from different 
editing and finishing applications into DaVinci Resolve. Once imported, you can also do a variety 
of editing tasks in order to better prepare a timeline for grading, to make last-minute changes 
requested by the client, or to set up timelines with leader elements and slates for final output.

The Edit Page

The Edit page consists of the Timelines list, which shows all of the timelines within the current 
project; the Media Pool as you saw on the Media page, where you can select media that you want 
to edit into a timeline; the Effects Pool, which shows all of the different video transitions that can be 
used within Resolve; the Source and Record Viewers, which let you perform various editing tasks; 
and the Timeline, which shows you whatever is selected in the Timelines list.

In the current example, a new timeline has been created in the Timelines list, containing all the clips 
in the Media Pool, ready for you to work on.
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The Color Page

The Color page is the heart of DaVinci Resolve’s grading capabilities; it’s where all of the image 
adjustment tools and functions are located.

The Color Page

The Color page consists of the Viewer, where you can see what you’re working on in the absence 
of an external video monitor, and where you can sample the image and adjust various on screen 
controls; the Gallery, where you can save reference stills and their associated grades for future use; 
the Node Editor, where you add and manage the various adjustments that go into making a grade; 
the Timeline, which lets you navigate your project and keep track of which clips have been worked 
on; and finally the various palettes that let you make color, contrast, and effect adjustments.

Clicking the Color Wheels palette at the far left of the toolbar reveals the traditional lift, gamma, 
gain, and offset controls that you may be familiar with from other applications.

Clicking the Auto Balance control in the Color Wheels palette
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Clicking the “A” button at the bottom left of this palette lets you make an automatic grading 
adjustment to neutralize the color and maximize the contrast.

Clicking the second clip in the Timeline. A rainbow indicator underneath the first clip shows that it’s been graded.

Clicking the second clip in the Timeline automatically updates every control in the Color page to 
the settings used for that clip. Since it’s not yet been graded, all of the controls are at their neutral 
default positions.

To make an adjustment to the contrast of this image, lightening it for example, you could drag the 
Gamma Master wheel to the right, to lighten the midtones of the image, and drag the Lift Master 
wheel to the left, to lower the darkest shadows again. The result is stretched contrast and an overall 
lighter image.

Adjusting the Gamma Master wheel

Now, if you wanted to alter the color of the image, you could adjust one of the Color Balance 
controls, for example the Gain control, pulling it toward blue to rebalance the lighter part of all three 
color channels at once, “cooling” off the image.

Adjusting the Gain Color Balance control by dragging the balance towards blue



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

GETTING STARTED1

25

After you make adjustments to clips that you may want to compare to other clips in the Timeline, 
you can save stills in the Gallery. A fast way of saving every shot in the Timeline is to use the “Grab 
All Stills from First Frame” command, available in the Viewer’s contextual menu.

Grabbing stills from every clip in the Timeline
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The Gallery Page

If your project has a lot of saved stills that you need to manage, you can use the Gallery page to 
help organize them all.

The Gallery page

The Gallery page consists of the Stills browser, which lets you import stills from other projects and 
databases, and which also contains the DaVinci Resolve Looks collection; the Project Memories 
where you can save multiple memories to apply to other clips; and the Project Stills browser, which 
lets you organize all of the stills in your project amongst multiple albums, and that contains the 
PowerGrade album, which lets you share stills and grades among multiple projects.
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The Deliver Page

Finally, when you’re all done with a particular timeline’s grade and you’re ready to finish, the Deliver 
page contains all of the controls necessary for rendering the finally graded media out of Resolve.

The Deliver page

The Deliver page consists of a Viewer, which lets you pick between rendering file-based output, 
and outputting to tape via a pop-up menu in the lower left-hand corner. The Timeline below it lets 
you choose a range of the current Timeline to output, as well as which tracks you might want to 
enable or disable prior to output. At the right, the Render Settings list contains all of the parameters 
governing how and where your final media is rendered. Below it, the Render Queue is where you 
can set up multiple renders to automatically occur, one after the other.

Note: If you’re rendering as part of a round-trip workflow where you’re sending the finally rendered 
media back to an NLE or finishing application for additional work, the current Timeline is always 
exported into the specified render directory, but you can also manually export the current Timeline 
to whatever format is necessary for handoff in the Edit page.

To Learn More…

Hopefully, this overview has given you a good idea where things are, and has demonstrated the 
logical, workflow-driven organization of the DaVinci Resolve user interface. If you want to continue 
touring Resolve in a hands-on fashion, there’s a more complete tutorial following this introduction that 
walks you through a much wider cross-section of the DaVinci Resolve interface, including how to import 
a project, how to use many more features in the Color page, and how to set up and execute a render.
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If you’re brand new to color correction, you might consider working your way through the following 
overview tutorial before continuing with the rest of this User Manual. The following series of 
exercises, using media that accompanies the DaVinci Resolve installer, are designed to give you a 
general idea of where everything is, and how the DaVinci Resolve user interface has been designed 
to let you work quickly.

Creating a New User and Importing a Project

If you want to set up a project in DaVinci Resolve so that you can see everything that is 
presented in this chapter on your own computer, you can download the tutorial media from  
http://www.blackmagicdesign.com/support. If you have the Mac OS X installer, you can also copy 
the tutorial media from the installer disc or disk image. However you obtain the media, you should 
copy it to the fastest disk that’s connected to your DaVinci workstation, to make sure you have the 
best experience.

Note: During installation Resolve sets up a default scratch disk for you. You can change this disk 
at any time using the Preferences window (Cmd,) or (Ctl,) or selecting from the menu bar under 
DaVinci Resolve. For more details on Setting Hardware Preferences refer to Chapter 2.

1. Before you begin, go to the Blackmagic Design web site (http://www.blackmagicdesign.com/
support) and then select the support section for DaVinci Resolve. Select DaVinci Resolve Lite 
and navigate to the Demo and Tutorial Clips section. Then copy the “Tutorial Clips” folder to 
the hard drive you’re using for media. Ideally, this will be the fastest volume on your system.

Tutorial

The Resolve installer
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2. Open Resolve.

 The DaVinci Resolve startup window appears, indicating the various steps taken by Resolve to 
launch. Eventually, the Log In screen appears.

3. Double-click the New User icon, and when the Create New User dialog appears, type in your 
name. It’s not necessary to enter a password if you don’t want to. If you have a picture of 
yourself somewhere handy, click Edit Picture, select your picture using the file navigation 
dialog, and click Open. When you’re finished, click OK.

User login 

Creating a new user
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4. Click the user you just created to select it, then click the Log In button. You could also simply 
double-click your user icon to open the Project Manager for your new user.

5. Double-click the Untitled Project icon to create a new project.

 When you first open a new project, you’re taken to the Media page, which is the first of five 
main pages used for organizing the different functions in DaVinci Resolve.

 Each page can be opened by clicking a corresponding button at the bottom center of the 
DaVinci Resolve window.

 These pages are arranged in order of workflow; the Media page is where you ingest dailies 
and manage media prior to having an edited project; the Edit page is where you import edited 
projects from other applications, and do editing and timeline management; the Color page 
contains all of Resolve’s color correction functionality; the Gallery lets you manage your stills 
and saved grades; the Deliver page is where you render your media and output to tape.

Project Manager

Dock selection of main Resolve pages



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

GETTING STARTED1

31

 For now, you’ll remain on the Media page, which is the media management interface of 
Resolve, in order to confirm the location of the media files used in this tutorial.

6. In the Library at the upper lefthand quadrant of the Media page, click the disclosure triangle 
next to the hard drive icon where you copied the “Sample Project” folder in step 1. Use the 
hierarchical file navigation controls in the Library to open the Sample Project folder, so you can 
see the five media files that you’ll be working with.

 Now that you’ve verified that the media you need is where it’s supposed to be, it’s time to 
import the project file that uses this media.

Library view with scratch disks and clip icons
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7. Click the Edit button to open the Edit page.

 The Edit page contains the Timelines list and the Timeline editor, and is where you import 
edited projects from other NLEs and finishing applications, and do simple editorial tasks to 
prep a project as necessary.

Edit page in its empty state prior to importing the XML and clips
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8. Choose File > Import AAF/EDL/XML…, then use the file import dialog to locate and select the 
“Cafe Tutorial” XML file, located in the “Tutorial Media” folder you copied in step 1, and click 
Open.

9. A Load XML dialog appears, with a number of options governing how to import the project 
data. All of the defaults are fine; in particular, make sure to keep the “Automatically import 
source clips into media pool” checkbox turned on. Click OK.

 Another dialog appears, telling you that “5 of 5 clips were not yet found.” Since you moved the 
location of the media, the file paths specified in the XML project file are no longer valid, and 
you must point Resolve to where the media is now located.

Import window for AAF and XML edit lists
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10. Click Yes in the clips not found dialog, and then use the file dialog to locate the folder you 
copied in step 1, then click OK.

 The Media Pool fills with the clips used in the Timeline, and the Timelines list now contains a 
Master Timeline and another timeline named “At the Cafe.”

 The clips themselves appear in the Timeline editor, in the order in which they originally 
appeared in the NLE from which this project came.

Folder window to locate clip folder for import

Edit page with clips imported to the Timeline
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11. This is a good time to save your project. Press Command-S, type a name into the Save dialog, 
and click OK.

 As always, it’s recommended to save early and often while you work. Now that you’ve 
successfully imported the project, it’s time to start working.

Navigating Your Project

Now that your project is set up, it’s time to move to the Color page, where you’ll be doing the 
majority of your work in Resolve.

1. Open the Color page by clicking the Color button at the bottom center of the Resolve window. 

 The Color page is where all the magic happens. All of the color correction functionality that 
lets you adjust color, contrast, light, and shadow, either selectively or indiscriminately, is found 
within the different palettes of this page.

 The Viewer at the upper left of the window lets you see the frame at the position of the 
playhead in the Timeline, located at the middle of the window.

DaVinci Resolve Color page
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2. Click the Play button, at the bottom of the Viewer, to play through the Timeline. When you’ve 
seen the whole Timeline play through, click the Stop button.

 The Transport controls let you play through your program, in real time if your system is powerful 
enough for the type of media you’re working on, so that you can see how the adjustments 
you’re making work as the clips play through. 

3. Click the fourth thumbnail in the Timeline at the center of the Resolve window.

 The Thumbnail timeline represents each clip in the Timeline as a single image, making it easy 
to spot the clip you need, and navigate to it by clicking.

4. Move the pointer to the Timeline ruler, above the Mini-Timeline that contains a series of thin 
bars, above the Thumbnail timeline. Then, click and drag the pointer along the Timeline ruler, 
to the left and right, to move through all of the clips.

Thumbnail Timeline with Mini-Timeline above

Using the pointer to scrub the timeline
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 The Mini-Timeline provides a way of seeing the actual edit such that clip width represents 
that clip’s duration. Dragging in the Timeline ruler lets you scrub the playhead directly. The 
Mini-Timeline can also be zoomed into and out of using the scroll wheel of your mouse. 
Furthermore, you can click any clip in the Mini-Timeline to jump the playhead to its first frame, 
as if you’d clicked a thumbnail. 

Video Scopes for Grade Evaluation

Now that you’ve seen how to navigate through the Timeline, it’s time to begin creating some 
simple color corrections. However, to help you make our corrections, you’ll open up the Video 
Scopes window.

 > Right-click the Viewer, and choose Show Scopes from the contextual menu.

The Scopes window appears, with four different video scopes onscreen at once, a Waveform 
monitor showing all three color channels overlaid over one another, a Parade scope showing the 
red, green, and blue channels lined up one next to another, a Vectorscope showing an analysis of 
the hues and levels of saturation throughout the image, and a Histogram showing a different plot 
of the three color channels, stacked on top of another.

 > For now, move the Scopes window up to the top of the screen, off to the right so it doesn’t 
get in the way of the palettes at the bottom of the Resolve window. You can resize the 
Scopes window by dragging the lower righthand corner up.

Tip: If you have a second monitor, you can drag the Scopes window onto it.

Video Scopes
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Making a Primary Correction

Now that you know your way around the Timeline, it’s time to start grading.

1. Click the Color Wheels palette button, at the far left of the toolbar.

 This opens the Color Wheels interface, showing Lift/Gamma/Gain controls for adjusting color 
balance and image contrast.

Selecting the Wheels palette for grading primaries

Color Wheels palette
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 Three color wheels, or Color Balance Controls, at the top with handles in the middle let you 
adjust the color balance (similar to tinting) of the darker shadows, the lighter midtones, and the 
lightest highlights independently of one another, depending on where the problem is.

 Underneath these, three Master wheels let you adjust the white point, the gamma (midtones), 
and the black point independently of one another, in order to alter image contrast and image 
lightness in different ways.

2. Click the thumbnail of the first clip.

 This clip is a bit dark, assuming you wanted a bright outdoors scene. The Master wheels will let 
you address this.

3. Drag the Gamma Master wheel to the right to lighten the image. As you do so, you should 
notice the middle of the Waveform move up, to show that the middle values of the image are 
getting lighter.

The dark image on the left is reflected in the parade and histogram

The graded image is brighter as scopes indicate
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 The image is lighter, but now the shadows are a bit washed out. Also, you should notice that a 
rainbow indicator now appears underneath the first clip’s thumbnail in the Timeline. This lets 
you know that clip 1 has a grade applied to it.

4. Drag the Lift Master wheel to the left, until the bottom of the waveform just touches the 0 line.

 This adds contrast to the image as we’ve stretched the distance between the darker and 
lighter regions of tonality. In addition to having a lighter image that no longer appears washed 
out, things also appear a bit sharper as a result of this adjustment. 

 However, we can do more to create purer color, since right now the image is a bit yellowish. 
In particular, if you look at the bottom of the Parade scope, you can see that the middle of the red, 
green, and blue waveforms are significantly offset. This indicates that there might be a color cast.

Timeline Thumbnails are updated to reflect the new grade

Extending the contrast of the scene 
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5. To get a closer view of the Parade scope without enlarging the Scopes window, choose “1 UP” 
from the pop-up menu at the upper righthand corner. This sets the Scopes window to display 
only one large video scope.

6. Then, click the option pop-up menu underneath and choose Switch View > Switch to Parade.

 Now, the Parade scope is easy to examine.

7. Move the pointer to anywhere within the Gamma Color Balance control, and click and drag 
towards blue/cyan.

Parade Scopes

Dragging the image towards blue/cyan
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 Move slowly as you drag, until the center of all three graphs in the Parade scope line up a little 
more, and the image looks more neutral (the middle of the blue graph will still be a bit lower).

 The image now looks contrasty and neutral, but the color is subtle. Raising the saturation, or 
color intensity, might help.

8. Move the pointer until it’s over the number of the Saturation parameter, below the Color 
Wheel controls, then click on the number and drag to the right to increase the saturation value 
using that parameter’s “virtual slider” control. A small orange arrow shows if you’re raising or 
lowering the value.

 Raise the value to somewhere around 68, and the image should look bright and colorful, 
without looking artificial. This makes the clip look good, so it’s time to move on.

The image now has a neutral look with good contrast

Saturation control below wheels
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Copying Grades

You don’t always have to start from scratch. Now that you’ve got one graded clip, you’ll see how that 
preexisting grade can be leveraged by other clips.

1. Click the second clip in the Timeline.

 Like the initial state of the first clip, this clip looks a bit dark, and a bit warm. So much so, in 
fact, that you may be able to copy the correction you applied to the first clip and use it as your 
starting point.

2. Click the first clip in the Timeline, then choose Color > Memories > Save Memory A. If you 
move the Scopes off to the side, you should notice that a small thumbnail of clip 1 now appears 
in the Memory A bank of the Gallery, so you can keep track of which grades you’ve saved to 
which memories.

3. Click the second clip in the Timeline, and choose Color > Memories > Load Memory A.

 That immediately copies the grade in Memory A to clip 2, and it’s a big difference. To see how 
big a difference you can turn the grade off and on to see a before and after.

Saving a still and the grade for that clip to the gallery
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4. Choose Nodes > Enable/Disable All Nodes, or press Option-D.

 It’s an improvement, but the highlights and shadows are a bit off, as can be seen by the 
misalignment of the tops and bottoms of the Parade scope.

 This, however, is an easy fix.

5. Drag the Gain Color Balance control towards blue/cyan until the tops of the red, green, and 
blue waveforms line up a little more closely (with the red channel still somewhat higher than the 
blue), and then drag the Lift Color Balance control towards blue/cyan until the bottoms of the 
waveforms line up a little better, too (but not too much, or you’ll make the blacks look blue).

 When you’re done, the image should look fairly neutral and bright, and the three channels in 
the Parade scope should be fairly even.

Scopes show the image is not balanced

A neutral and balanced grade with scopes aligned at the top and bottom
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Grading with Custom and Hue Curves

Things look good, but again the shadows look a bit washed out. Assuming you want denser looking 
shadows, but you don’t want to crush the blacks so much that you end up clipping detail, this is a fix 
you can make with DaVinci’s Custom Curves, in the Curves palette.

1. Hold the Shift key down, and click on the Luminance curve about one third of the way from the 
top to add a control point without moving the curve.

 This locks off the top of the curve without making any changes.

2. Click on the Luminance curve about one third from the bottom, and drag the curve down to 
darken the shadows without clipping the signal at black.

 You may now find yourself wanting to readjust the top control point you added, dragging it 
up to make the highlights more intense. You can do this using the Large View Custom Curves, 
which make it easier to make fine adjustments using curves.

Custom Curves palette

Adjusting curves with all channels ganged
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3. Click the Large View button underneath the curves.

4. When the Large View curves window appears, adjust the two control points you’ve created 
to create a pleasing S-curve that lightens the highlights and darkens the shadows, without 
clipping the signal at the top or bottom of the Scopes window.

 At this point, the overall Saturation of this shot is a bit much, but we don’t want to desaturate 
the image completely. Instead of using the overall Saturation parameter, you’ll use Hue Curves 
to selectively alter image saturation.

5. Double-click the Saturation parameter in the Color Wheels palette to reset it to 50. Double-
clicking the name of any parameter resets it to its default value.

Selecting the large curves view

The large Custom Curves view



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

GETTING STARTED1

47

6. Choose “Hue Vs Sat” from the mode pop-up menu in the Curves palette.

 Different palettes have a variety of modes, with different controls. These additional modes are 
available from pop-up menus in each palette. In this case the Hue Vs. Sat curve lets you raise 
or lower the saturation of specific ranges of hues throughout the image.

7. Click on the woman’s face, and drag within the highlighted side of the woman’s face.

 This automatically adds a range of control points to the red portion of the curve, corresponding 
to the part of the image you sampled.

Selecting Hue vs Sat in the Curves palette

Hue vs Sat curves palette

Using the color picker to select the skin tone
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8. Drag the middle control point up to add saturation to the woman’s face, and to the red counter 
in the foreground.

 This adds color intensity to the clip, but just where you want it.

Saving Stills and Using the Gallery

Now, because this clip is inside of the cafe, and there are other cafe clips in the Timeline, it would 
be a good idea to save a reference still for future comparison.

1. Right-click the Viewer and choose Grab Still from the contextual menu to save a still of that clip 
to the Gallery.

2. Now, click the thumbnail of clip 3.

 Clip 3 is also dark, but it’s a very different kind of shot from the others, so copying a grade 
directly might not be the best idea. Instead, you can create a split screen with the still you 
saved, and then make adjustments to match the two clips.

3. Double-click the still in the Gallery to enable it as a split screen in the Viewer.

With the skin tone selected you can now adjust the curve

Double click the Gallery still to open a split screen in the viewer
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4. Then, drag the playhead in the scrubber bar of the Viewer until the hand and the cup come 
into view, for a better comparison against the other scene.

 Now, you can see a comparison of the two clips. More importantly, however, you can see a 
split screen comparison of the Parade Scope graphs of both images.

5. Drag the Gain Master wheel to the right until the tops of clip 3’s graphs are close to, but not 
quite, equal height with the split screen still. Then drag the Lift Master wheel to the left until the 
bottom of clip 3’s blue graph just touches 0, as does the blue waveform of the split screen still.

 Image contrast is now a pretty good match, but the color is a bit off.

6. Drag the Lift Color Balance control just a bit towards blue, until the bottoms of clip 3’s graphs 
more closely match the bottoms of the split screen still, and then drag the Gamma Color 
Balance control slowly towards magenta until the middle of clip 3’s Parade graphs more closely 
matches the middle of clip 2’s graphs.

Split screen with Gallery still on the right

Adjusting the gain to match both images
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 Tip: To get a better sense of how two clips match, you can drag the split screen seam in the 
Viewer all the way to one side so that only the Still Store is showing, then press Command-W 
repeatedly to show and hide the still, flipping between it and the clip you’re comparing it to.

Using Power Windows and Tracking

Now the environment looks good, but the cup itself doesn’t really look like anything special. This 
can be fixed using a Power Window.

1. Close the Scopes window, choose View > Show Reference Wipe to turn the split-screen off, 
and then add a node to the Node Editor by choosing Nodes > Add Serial Node (or press 
Option-S).

 This adds another node to the Node Editor. Each node contains one or more adjustments, 
and by combining several nodes worth of adjustments, you can build extremely sophisticated 
grades. In this case, you’re going to create a “secondary” correction, which is an adjustment 
that you’ll be limiting to just one area of the image. There are several ways of making a 
secondary adjustment, but in this case you’ll do it using a Power Window, which is a shape you 
can use to isolate the adjustment you’ll be making.

The Node editor showing two nodes in series



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

GETTING STARTED1

51

2. Drag the playhead in the Viewer all the way to the end of the clip, then click the Window 
palette button, in the toolbar, to open up the Power Window controls.

3. Click the button to the left of the Circle icon to turn on a circular Power Window.

Selecting the Power Window palette

Selecting and turning on the Circular window
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 An on-screen control should appear in the Viewer.

4. Drag the on-screen control so that the circular shape is centered on the cup, then drag one of 
the green handles to enlarge the shape so that it surrounds the cup.  Finally, drag one of the 
magenta handles outward to soften the edge of the Power Window you’ve just created, so 
that you end up with a shape that resembles the following screenshot.

5. Now that the window is in position, drag the Gamma Master wheel in the Color Wheels palette 
to the right to brighten the cup, and then drag the Lift Master wheel to the left to darken the 
shadows. The result stretches contrast, making the cup appear more vibrant. However, this 
also boosts the saturation so that the inside of the cup starts looking a bit red, so drag the 
Saturation virtual slider to the left to reduce saturation until the cup still has color, but not too 
much color.

 This makes the cup stand out a bit more, but the problem is that the cup moves, but the 
window at this point doesn’t. You can make the window follow the cup using Tracking.

The Viewer now shows the Circular Power Window

With Gamma adjusted the cup now stands out
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6. Click the Tracker palette button, in the toolbar.

 The Tracker palette lets you automatically match a Power Window to the motion of the thing it 
surrounds.

7. Click the Track Backwards button.

Selecting the Tracker palette

Initiating a track
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 Resolve automatically finds trackable points on the cup, and analyzes the clip in reverse to 
make the shape follow the cup until the edge of the screen is reached.

 At this point, playing through the clip will show the shape moving along with the cup, and 
limiting your adjustment to the cup as it moves through the screen. 

8. Right-click the Viewer and choose Grab Still to save a still of the current clip to the Viewer, for 
future use.

Secondary Adjustments Using Qualifiers

Now that we’re finished with this clip, time to move on to the next one.

1. Click the thumbnail of clip 4, then right-click the still you saved of clip 3, and choose Add 
Correction to apply its grade to clip 4. 

 The grade from clip 3 is a good starting point for clip 4, but it has the Power Window that was 
applied to the cup, which obviously doesn’t make sense for this clip. Fortunately, you need 
another node for your next operation anyway, so you can simply reset node 2 in order to use 
it for something else.

2. If it’s not already selected, double-click node 2 in the Node Editor, and choose Color > Reset  
Selected Node Grade to reset its parameters, while leaving it in the Node Editor, ready for 
future use.

Resolves automatically finds dozens of tracking points
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 The image looks good, but we could go one step further and give the oranges a little more 
zest. Since they’re a uniform color, we can use HSL Qualification to isolate them for a different 
kind of secondary adjustment.

3. Click the Qualifier palette button in the toolbar.

 The HSL Qualifier lets you pull a chroma key, and use it to limit an adjustment to just that area 
of the image. You should notice that the eyedropper (the first of the three Selection Range 
tools) is highlighted orange. If not, click it.

Ungraded source image

Selecting the Qualifier palette
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4. With the eyedropper enabled, click and drag around the middle of the top orange, to sample 
as much of the middle tones of the orange as you can (but not the specular highlights or 
darkest shadows).

 The qualifier graphs update to show the range of hue, saturation, and luma that you’ve isolated.

5. If you want to see the matte itself, you can click the Highlight button to turn a highlight preview 
on and off.

 The highlight shows the isolated area in color, and the part of the image that won’t be affected 
by your adjustment in flat gray.

Using the color picker to select the orange

Turning on the Highlight

Viewer displaying the selected HSL qualification with the balance in gray
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6. Turn the highlight off, and drag the Saturation virtual slider to the right to raise the saturation 
of just the oranges.

 Now the oranges really stand out (as does the woman’s orange skirt), but the rest of the image 
stays the way you wanted it to.

Using the Sizing Palette

Now it’s time to move to the last clip of the sequence.

1. Click the thumbnail of clip 5.

 This clip superficially resembles clips 2 and 3, but if you tried copying the grades from the stills 
you saved of those clips, you’d find that it makes this clip too blue, owing to all of the outside 
light in the shot. However, it turns out that the grade applied to clip 1 is a good starting point 
for this shot, and there’s another way of easily copying grades that you can use as a shortcut.

2. With clip 5 selected in the Timeline, middle-click clip 1 (the middle button of one’s mouse is 
usually assigned to the scroll wheel).

With increased saturation the oranges now ‘pop’

The grade from clip one is copied to clip five with a center mouse click
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 This immediately copies the grade from clip 1 to clip 5, without needing to save either a 
memory or a still to the Gallery. At this point, the color of the clip looks reasonable, but the 
framing isn’t particularly good for the cup. In this case, you can use the Sizing controls to pan 
and scan the image, creating the framing you need.

3. Click the Sizing palette button, in the toolbar.

 The Sizing palette contains all of the parameters available for panning, tilting, rotating, 
zooming, squeezing, and flipping the geometry of the image.

4. Drag the Zoom, Pan, and Tilt virtual sliders to zoom into and move the image until the framing 
resembles the following screenshot.

Selecting the Sizing palatte

Zoom, pan and tilt to place just the cup and table in the frame
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Rendering in the Delivery Page

Now that you’ve made adjustments to all five clips in this sequence, it’s a good point to stop grading 
and render out a version of this project for the evaluation of your hypothetical client.

1. Click the Deliver button, at the bottom of the Resolve window, to open the Deliver page.

 The Deliver page is where you render your color corrected program, creating the final media 
that can be sent to another NLE or finishing application for whatever final work needs to be 
done, such as titling or additional effects work.

 You have the option of rendering each clip as an individual media file, or you can render the 
entire Timeline as a single piece of media. In this case, you’ll use the latter option to output an 
evaluation movie.

2. Make sure that the “Render timeline as” radio buttons are set to “Single Clip,” which is what 
specifies that Resolve will render the entire Timeline as a single clip.

Deliver page
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3. In the Render Settings list at the right, choose a clip format and codec from the Render 
to and codec pop-up menu. If you have Final Cut Pro installed on your system, you might 
choose QuickTime Apple ProRes 422 (LT). If you’re an Avid user, you might choose one of the 
DNxHD codecs.

4. Click the Browse button, and use the file browser to choose a directory to render the media to.

 After selecting a directory you can also add a subfolder by using the slash (/) after the directory 
name and then entering a new folder name. The initial directory could be, for example, on the 
desktop, /Volumes/Macintosh HD/Users/Your Name/Desktop, and you can add another folder 
with /Renders. The new folder for the rendered clip would be /Volumes/Macintosh HD/Users/
Your Name/Desktop/Renders.

 Note: If this folder has clips which are the same file name as your new clip, Resolve will warn 
you, and if you accept, it will overwrite these clips.  Of course, if the clips have a different name 
the existing clips will not be overwritten.

5. Once all this is done, click the Add Job button, underneath the Render Settings list, to add the 
current render setup to the Render Queue.

 You can add as many variations of jobs as you like to the Render Queue. For example, 
you might set up different versions of output, using different frame sizes, codecs, or 
organizational conventions.

6. Click the Start Render button at the bottom of the Render Queue to begin rendering.

 A progress bar will show you the countdown of how much longer rendering will take, while the 
Viewer shows you what’s being rendered at that moment.

 When rendering is complete, the progress bar turns green, and that job appears with a green 
checkmark. At this point, you should save your project again, and take a well deserved break. 
This is the end of the tutorial.

Obviously there are many more features available in DaVinci Resolve, but this tour should have 
given you a good idea where, in general, everything is. The rest of this User Manual will go into 
specifics about all of these features and more.

Adding a render job to the queue


